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Organtze.Leverage. Succeed. Memorial & Honorarium Gifts — Add the Option to your Online Donation
Forms, and How to Run Searches and Build Reports on these Type of Gifts in the Database

Author: Kristenson, Joel
Last Updated: 2016-11-3

Overview

This article is for nonprofit customers who want to collect and track gifts in honor or memory of someone. It walks through the steps to add the
option to your donation iFrame form, and how to run searches/reports on the data once it’s in your database.

¢« Tip: Use the Ctrl+F hot key to jump to different sections of this article (example: “#1”, “#2” or “Related Resources”.

Outline

#1 Add the Memorial/Honorarium Option to your Online Donation Form
#2 Searching for Memorial/Honorarium Gifts in your Database
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& TrailBlazer

Organtze.Leverage. Succeed. Memorial & Honorarium Gifts — Add the Option to your Online Donation
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#3 Build Reports (Add Columns) for Memorial/Honorarium Gifts
#4 Related Resources

#1 — Add the Memorial/Honorarium Option to your Online Donation Form

To add this option to your online donation page (iFrame):
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Powered by —
€ ToilBlazer share: EIEIEE o o
- [
Yes, I want to receive future email updates.
) o Select a Restricted Allocation Fund Below
v Show my donation on the website ticker.
Comment 0 2016 Disaster Relief Fund
a0 2016 General Fund
.00 2016 Scholarship Fund
Volunteer
Assist with Event planning
Twil work on your newsletter Make my donation in Honor or Memory of
Taking Registrations at Events
Honor or | yone B -
Memory
Select Rider to Support Please enter ||
*Full Name* &
Chad B *Address*
o
Jim
Joel
Kevin Make a donation in
Mark _ memory or honor of
pat Employment Information
) ) someone.
Sue Required by Federal and State Election Laws
Tom * Employer
* Occupafion
Please select your email preferences
|\
Annual newsletter Payment
Critical updates only regarding major news
@ Credit Card
Monthhy newsletter 3
Bank Account eCheck
Please never contact me by email _
DISCOVER
Quote of the day notifications VISA__ @ " @
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You’ll need to check the Include Honor of box in website configuration:
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B) Settings  Help

Application Menu «|| File - Edit - | ) # Frame Wizard
E % | Site Title: Demo Monprofit - Joel Refresh web pages
faets Meta Description: Click here to refresh vour web usi
B Dashboard updated specifications.
i+ g Organization Meta Keywords:
» § Calendar/Tasks Theme Name: default
> B Canvassing Flat Shipping Fes: 00
» Ep contact
i+ @ Communications [ Enable double Opt-In for all forms
[» a Financial
4 Gy System Manager | Site Settings | Calendar Events| Donations |5igr1up Email | Signup Short | Signup Without Attributes | Signup Attributes | Signup F‘oﬁl
B system Gallery Page Setup | Donation Amourts | Recuming Frequancy | Related Lists | Email Response | Live Preview {Donaﬂons.aspx?\far-—Qﬂ
. Settings Is Federal (Employer / Occupation) “Required Include Disclaimer ’@De{ault Dis[:|ai|'|1ﬁ|’l ’ Insert Security Text
=
& Customize Labels Is Email Address “Required [ Include “Required Confirm Eligibility Checkbox

&F Payment Gateway

& Website Configuration 4—

Pre-Check Email Opt-In <br=<br=<span style="Tont-weight: bold; "=For the .

security conscious</span> - You may notice this

& Update Unique Search Values (Drop Downs) [#] Is Phone Number *Reguired page does not display the padlock or https in the
address bar.&nbsp; However, the portion of the
[ [ Tools [ Include Restricted Funds (Allocations) Dropdown Style page above that captures your name and credit
card information is connected by secure server to
: our database provider (Trail Blazer).&nbsp; <span
DlsableCaptcha style="font-weight: bold;">Their serwver IS,
securing wvour credit card transaction</span=.
[¥7] Include Comments &nbsp;Depending on your browser, you can verify
this by right mouse clicking on the white space
. . [#] Include Honor of inside the the gray borders near your name and
Thls Settlng address.&nbsp; From the menu select Properties. -
Include Middle Mame
H Include Attributes Component
WI" turn the [#] Include Nick Name )
. I . 1 Include Lawn Sign C Attribute Folder 1: l\Voiunteer Roles VI
- nclude Lawn Sign Component .
memorla /ln Attribute Folder 2: ’\seiect.ﬁ SINGLE Rider to Donate Towsz v]

Include Donation Other unt Adtribute Folder 3: ’\Please select your email preferences v]

honor of option

Include Donation Level Description(s) Attribute Folder 4: l{no olders v]
on for your Include Donation Ticker Labels
d onation form . Ticker Size: 10 Contact Bax:
Ticker Start Date: 6/16/2016 w Amount Ba:
Display Position of Donation Amount(s) Frequency:
Location: [ - Button: Donate Now
Fund Bowx: Select a Restricted Allocation Fund Below

Hanor Box: «b>Please enter *Full Name* & *Address*
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This requires appropriate security clearance.

After that setting is turned on you’ll need to click [Save] in the bottom-right, and then click the blue hyperlink in the top-right that says ‘Click here
to refresh your web pages using updated specifications’.
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File - Edit - | &) ## Frame Wizard

Click here to refresh yvour web pages using

Flat Shipping Fee: .00

[] Enable double Opt-In for all forms

Site Title: Demao Monprofit - Joel Refresh web pages
Meta Description:

cription updated specifications.
Meta Keywords:
Thems Name: default

N

2

| Site Settings I Calendar E\rents| Donations |5ignup Email I Signup Shart I Signup Without Attributes I Signup Atributes I Signup F‘ost|

Page Setup | Donation Amounts I Recuming Frequency | Related Lists | Email Response | Live Preview {Donatinns.aspx?verh—2}|

|s Federal (Employer /! Occupation) “Reguired
|s Email Address *Required
Pre-Check Email Opt-In
Is Phone Number “Required
[7] Include Restricted Funds (&llocations) Dropdown Style
Disable Captcha
Include Comments
Include Honar of
Include Middle Name
Include Mick Name
[ Include Lawn Sign Component
Include Donation Other Amount
Include Donation Level Description(s)
Include Donation Ticker

Ticker Size: 10
Ticker Start Date: 6/16/2016 =
Display Position of Donation Amaount(s)

Location: ’

Include Disclaimer [@De{ault Disclaimer ] ’ Insert Security Text

[7] Include *Required Confirm Eligibility Checkbox

<br=<brx=cspan style="font-weight: bold;">For the .
security conscious</span= - You may notice this
page does not display the padlock or https in the
address bar.&nbsp; However, the portion of the

page above that captures your name and credit

card information is connected by secure server to
our database provider (Trail Blazer).&nbsp; <span
style="font-weight: bold;"=Their server IS

securing your credit card transaction</span=.
&nbsp;Depending on your browser, you can verify
this by right mouse clicking on the white space
inside the the gray borders near your name and
address.&nbsp; From the menu select Properties. hd

Include Attributes Component

Attribute Folder 1: [Wulunteer Roles A ]

Aftribute Folder 2:  |\Select A SINGLE Rider to Donate Towz ¥ |

Attribute Folder 3: [\Piease select your email preferences v]

Adtribute Folder 4: [-e no folder> ~ ]
Labels
Contact Bou:

Amount Boo:

Freguency:
Button: Donate Mow

Fund Box: Select a Restricted Allocation Fund Below

T — P - o o .

m
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« Tip: You can adjust the label in this area as well. For instance you may want to request that the donor enters the address for the person the gift
was made in honor/memory of, among other things. My example of this modification is below.
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) Settings  Help - 5 X
*» (| File ~ Edit - | g % Iframe Wizard
Site Title: Dema Monpraofit - Joel Refresh web pages
Meta Description: Click here to refresh your web pages using
updated specifications.
Meta Keywords:
Theme Name: default
Flat Shipping Fee: .00
[] Enable double Opt-In for all forms
| Site Settings I Calendar Event5| Donations |5igr|up Email | Signup Shart I Signup Without Attributes I Signup Attributes | Signup F‘oa|
Page Setup | Donation Amounts | Recurming Frequency | Related Lists | Email Response | Live Preview {Dnnations.aspx?\rer——;_'ﬂ
- — - - - — [ L =] 0
Is Email Address “Required [] Include *Required Confirm Eligibility Checkbaox |
Pre-Check Email Opt-In <br=<br=«<span style="font-weight: bold;"=For the .
. . security conscious</span= - You may notice this
- Is Phone Number “Required page does not display the padlock or https in the
- address bar.&nbsp; However, the portion of the
@ | ||| [C] Include Restricted Funds {Allocations) Dropdown Style page above that captures your name and credit A
E card information is connected by secure server to |5
: our database provider (Trail Elazer).&nbsp; <span
Disable Captcha style="font-weight: bold;">Their serwver 15
o Include C securing wvour credit card transaction</spans.
(w] nclude Comments &nbsp;Depending on your browser, you can verify
- — this by right mouse clicking on the white space
it - -
o Include Honor of inside the the gray borders near wour name and
J address.&nbsp; From the menu select Properties. -
o— Include Middle Name
o Include Attributes Component
o Include Mick Name =
q _ Atribute Folder 1: [Wuiunteer Roles "] =
[] Include Lawn Sign Component . =
Atribute Folder 2: | \Select A SINGLE Rider to Donate Tows ~ |
Include Danation Other unt Attribute Folder 3: [\Piease select your email preferences v]
Include Donation Level Description(s) Attribute Folder 4: [<no folders .,]
Include Donation Ticker Labels
' . Contact Box:
Ticker Size: 10 .
! el Smount Bo Tip: you can change th
Ticker Start Date: 6/16/2016 - '
Display Position of Donation Amount(s) Frequency: memﬂl'y/hﬂnﬁr-ﬂf |E b E
Location: [ Buttan: Donate Mow th t d.
at displays on your
Fund Bex:
: L -
iHonor Bo: I <b>Please enter *Full Mame* & *Address* donat'nn form here_ b
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#2 — Searching for Memorial/Honorarium Gifts in your Database

When someone gives a gift through your donation form that’s in honor or memory of someone, like this example:
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Powered by
G‘TFCJH[B’QZEF Share: BOE o
T 4P OUE 155437
* Phone |(866) 909-8700 Make my donation
* Email |jkristenson@traiblz.com single One Time Donation H

v Yes, [ want to receive future emai updates.

¥ Show my donation on the website ticker. Select a Restricted Allocation Fund Below

Comment | You rock my socks off! 10 2016 Disaster Relief Fund
10 2016 General Fund
2016 Scholarship Fund
10
Volunteer

$30.00 of $45.00 allocated.
V' Assist with Event planning

Twil work on your newsletter Make my donation in Honor or Memory of

In memory of B -

Please enter  steye Jobs
*Full Name* &

v Taking Registrations at Events
Honor or
Memory
Select Rider to Support

¥ Chad [ *Address* | 2066 Crist Dr.
Dan Los Altos, Calfornia 90210
- - -
Jim Example jmemorial gift.
Joel
Kevin
Mark
pat Employment Information
Sue Required by Federal and State Election Laws
Tom * Employer 114 plazer

* Qccupation | Professional Dishwasher
Please select your email preferences

v Annual newsletter Payment

V' Critical updates only regarding major news k

® Crodit Card
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The details display on the email receipt your database admins should receive by email as well as the receipt the donor gets automatically:
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Hid9 3« % |= Donation Accepted - Single - 545.00 by Joel Kristenson - Message (HTML) lim

_File Message & e

X Mesti '-EJ Archive Eﬂr @-Rules - E\] @Mark Unread aq* # &
gnere x _% ‘E ‘—% a s 5# To Manager - I$E_|Onvar\h::ute: — .‘J m Categorize = & l%' ¥%
%Junkv Delete | Reply REAFIJIIy Forward E‘é More - |_“l-] Team E-mail - Mcilre ) Actions - P0||I§|'nv ¥ Follow Up ~ Tranvslate s - Zoom
Delete Respond Quick Steps P Move Tags IF} Editing Zoom
Fram: Demo Monprofit Joel <jkristenson@trailblz.com = sent: Wed 11/2/2016 2:42 PM
Ta: Joel Kristenson
Cc
Subject: Donation Accepted - Single - 545.00 by Joel Kristenson
I This sender failed cur fraud detection checks and may not be who they appear to be, Learn about spoofing Feedback B I
Name on Card Joel Kristenson
Donor Name Joel Kristenson
Street 9110 Golden Valley Rd
Street 2 Apt. 10
City Golden Valley . . . . .
State MN Details of a memorial gift will display
ZipCode 2421 here in the automated email receipt.
Phone (866) 909-8700 / 3
Email [kristenson@trailblz .com |
Amount $45.00
'::""'“'”em""f Steve Jobs 2066 Crist Dr. Los Altos, California 90210
Comments:
You rock my socks off!
F m [ | |
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You can run search queries for these gifts in the Contributions list under the Memory/Honor tab.

In my 1% example below | searched for all gifts made in honor of anyone by selecting that option from the drop-down menu:
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_—
§) Setings Help 3
Application Menu <l | =3 Search Reset | 9 New (=Bl W) File » Edit - | ) | Applyto Pledges | Contributions
E & T S —
Tasks ’ml—ﬁenem | A Memory/Honor IGaeway | Contact ISQL |
3 Dashboard
3 (% Organization o |

! G g Tree
2 % Canvassing ~ ]

4 % Contact Persan: \
EB Contacts 2

@ Addresses

@ Households

EE Contact Relationships

4 ‘& Conbributions/Pledges

@y Contributions <— 1
& Contribution Allocations
@ Contribution Matches
‘@ Contribution Notifications
Pledges
Pledges, Detail
[=9 Thank You Letter - Contributions

il Reports =8 Edit Sort [T Format » 53 Wrap | =% Export 2 Print Pivot
3 .'“'I';\; od n:to Sales plaisse = :
[ O Logs
4 @ Communications Contact Last First App_lied gz;; es " I:E"lk jihank ik=nk Check N
b a Financial jinl * Date ) Name Name MI Amount glg:zl;:g [Per Depasited Lettar \E)oa:e \I:‘;zounsall & Street Street 2 City
IS (% System Manager Contact] Sent
00 .00 9110 Golden Valley Rd Apt 10 Golden Valley
46500 4/5/2016 | 12796 Kristenson Joel Anders 200.00 00 .00 9110 Golden Valley Rd Apt 10 Golden Valley
5600 1/29/2015 | 12796 Kristenson Joel Anders 25,000.00 00 .00 2/1/2016 9110 Golden Valley Rd Apt 10 Golden Valley
5596 10,7/2014 | 12796 Eristenson Joel Anders 50.00 00 .00 2/1/2016 9110 Golden Valley Rd Apt10 Golden Valley
5595 10/6/2014 | 12796 Eristenson Joel Anders 10,000.00 00 .00 2/1/2016 9110 Golden Valley Rd Apt10 Golden Valley
5591 10/6/2014 | 12796 Eristenson loel Anders 1,234,506 00 .00 2/1/2016 9110 Golden Valley Rd Apt10 Golden Valley
5590 10/6/2014 | 12796 Kristenson Joel Anders 123.45 00 00 2/1/2016 9110 Golden Valley Rd Apt10 Golden Valley
5588 10/6/2014 | 12795 Kristenson Joel Anders 25,000.00 00 00 2/1/2016 9110 Golden Valley Rd Apt10 Golden Valley
5585 9/29/2014 | 1279 Eristenson loel Anders 5,000.00 00 .00 2/1/2016 9110 Golden Valley Rd Apt10 Golden Valley
5577 7/30/2014 | 12835 Van Kirk Theodaore 1,945.00 00 .00 2/1/2016 123 Daring Street. MNorthumberla...
5558 6/7/2012 12818 Burton lane £95.00 00 00 4567 Oak St Fort Atkinsan
5292 4/23/2012 | 12775 Phillies 100.00 00 .00 3654 65 trail cir Rochester
5277 3/30/2012 | 12768 Meier David 350.00 00 .00 6578 E Hampton fve 5 Minneapaolis
5276 3/28/2012 | 0414 Gibson James 150.00 a0 00
5254 2/22/2012 | 12741 Sheehan Ann 500.00 00 .00 12313 645 Penn 5t Reading
5252 2/16/2012 | 12739 Powers Gail 216.15 00 .00 1220 Spruce 5t Philadelphia
5251 2/13/2012 | 12738 Bamfard Hancy 1,000.00 00 .00 1567 Summit Ave E Renton
5241 2/7/2012 | 12738 Jacobowitz Melissa 1,500.00 00 .00 1596 Hwy 43 Las Vegas
5237 2/6/2012 | 11106 Hanson Heidi Rag 700.00 00 .00 14961 Sumter Ave 5 Savage
5236 2/6/2012 | 12725 Mercer Cyrstal 300.00 300.00 300.00 15967 East Ave Greensboro
[ | 5034 2022012 | 12722 Watt lennifer 1 250.00 00 00 &1 7 7394 1657 90th Aue § Rirminaham

B a | | \ | | | | 13388831 112500] [ 1 [ ] I | |



http://www.trailblz.com/kb

& TrailBlazer

Organtze, Leverage. Succeed. Memorial & Honorarium Gifts — Add the Option to your Online Donation
Forms, and How to Run Searches and Build Reports on these Type of Gifts in the Database

You can filter the search further by the specific person a gift was made in honor/memory of. In my 2™ example | filtered to all gifts made in honor
of Steve Jobs:

@ Settings  Help
Application Menu <« || <3 Search %, Reset | 4k New o o @ File - Edit - |/ | Applyto Pledges | Contributions

Be® i3

Tasks Favorites | General | 4% Memory/Hanor |0Lher IGBiEWEI I Contact | S6L |
. [ Dashboard
3 % Organization @ |

s Type:
[ @ Canvassing ~ vPE —_

4 % Contact Person: Steve Jobs

EH Contacts

@ Addresses

@ Househalds - -

3 Contact Relationships Filter the search further by adding the name
Contributions/Pled - -

O ontons/Pledaes of who the gift(s) were in honor/memory of.

@ Contribution Allocations
“# Contribution Matches
iy Contribution Motifications
E Pledges
[&d Pledges, Detail
[=4 Thank You Letter - Contributions

1> Reports §§ Edit @ Sort @Format - S3Wrap a} Export & Print @ Pivot
1+ % Product Sales
I+ > Logs
I % Communications ]
IS 5 Financial ID & last Name First Name Date Amount Check#  Street Street 2 City State ?:de Cycle ::ztn:lzr:jt TR;;:rrence
i+ Ug System Manager
L
45584 Aaron Mithran 11/3/2016 5,000.00 5645 585 Vista Ave SE Salem OR 97302 Calendar Year 2016 Check Single
3| z 5,200.00 || .}[|

If you run these searches often, you can save them as a favorite for future use. It may be useful to use sql wildcards with these searches as well, for
instance if you don’t know the exact spelling of the memorial/honorary person.

You’ll notice that be default there aren’t any columns related to memorial gifts in the report:
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By default there aren't any columns related to memorial gifts in the Contributions list.

<o Search . Reset | 4p New |5 HcF b File = Edit - | 0 | Apply to Pledges | Contributions |
S8 Edit ) Sort ) Format ~ =3 Wrap | ®% Export ¢ Print | ) Pivot .
. Open Thank
D 4+ Date Ict;’”tm ha;rtn . ::; . MI Amount ﬁ::il:s: Fp':fges Deposited ‘Lrﬁt‘;er 523”" ?Sﬂ”ckau ;h“" Street Street2  City State Ei:d . g:f:‘it
Pledges Contact] Sent Date Done
0 00 00 White Bear Ave White Bear La... | MN 55110 [
3626 11/30/2010 | 10964 MeSpadden | Laur Marie 10,000.00 00 00 604 College Ave Mew Paris ™ 46553 |
3655 13/16/2010 | 10970 Diaz Elizabeth 100.00 00 00 133 E Minnehaha Suite 22 | Mpls MN 55555 |
3906 12/22/2010 | 10974 Adams Leticia 100.00 00 00 1597 87th Ave 5 Minneapolis | MN 55402 |
3907 12/23/2010 | 10976 Lloyd Chelsea 575.00 00 750.00 401 Richmond St W Toronto on M5V 388 |
3910 12/29/2010 | 10979 Bass Carly 275.00 00 500.00 7896 Cumberland Ave W Santa Barbara | CA 93101 |
3913 1/4/2011 | 11072 Uliman Talia 250.00 00|  3,000.00 7893 Washington St salt Lake City | UT 84101 |
3914 1/7/2011 | 11075 Gerdts Amy 276.00 00 2,000.00 1596 47th Ave 5 Concordia MO 64020 |
3916 1/7/2011 | 11077 Pierce Vanessa 300.00 00 00 1234 Washington StE Salt Lake City | UT 84121 |
3917 1/6/2011 | 11079 Lollar Amanda 600.00 00 00 1593 Batdrive E Mineral Wells | TX 76067 |
3918 1/6/2011 | 11080 Bischoff Sara 750.00 00 00 123485 3633 Aldrich Ave S Minneapalis MN 55409 |
3919 1/18/2011 | 11082 Winheim oy 500.00 00 00 500 15978 Washington Blvd Tampa FL 33603 |
3922 2/10/2011 | 11090 Marrinan Michael Gordon 100.00 00 00 3458 Indiana Ave N Robbinsdale MN 55422 |
3923 2/25/2011 | 11092 Griffith Mary 1,000.00 00 750.00 1597 45th Ave 5 Chicago L 60647 |
3925 7/22/2011 | 11094 Garretson F... | Susan 500.00 00 .00 123 E Minnehaha Suite 22 Mpls MM 55555 |
3929 3/1/2011 | 11097 Fairbanks Chelsea Deann 875.00 00 .00 7891 MountCurve Blvd St Paul MN 55116 |
3930 3/2/2011 | 11099 Miller Amy Michele 777.00 00 00 1547 133 E Minnehaha Suite 22 | Mpls MN 55555 |
3933 3/4/2011 | 11102 Roehl Mary Sue 757.00 00|  3,000.00 159 Hampton Bivd E Loretto MN 55357 |
3936 3/8/2011 | 11106 Hanson Heidi Rae 75.00 00 00 1597 14961 Sumter Ave 5 savage MN 55378 |
3937 3/7/2011 | 11109 Mascimento | Mathan 250,00 00 00 1596 123 E Main Morfolk VA 23510 |
3938 3/14/2011 | 11111 Kentsa-Siaka | Alvine Laure 1,500.00 00 00 7265 146th Way W Apple Valley MN 55124 |
4144 3/15/2011 | 11115 Taylor-Mani... | 5arah Elizabeth 159.00 00 00 1808 Englewood Ave St Paul MN 55104 |
149 3/22/2011 | 11120 Crawford Kimberly Rose 1,000.00 00 00 1021stStW Duluth MN 55802 |
4150 3/24/2011 | 11121 Beecroft Lisa Marie 2,000.00 00 00 3755 Auger Ave White Bear La... | MN 55110 |
4151 3/25/2011 | 11127 Myers Timaothy 650.00 00 00 159 Main St Fountain Valley | CA 92708 |
4154 3/26/2011 | 11131 Laszewski ill Diane &00.00 00 3,000.00 1597 7 Sandra Lee Dr E St Paul MN 55119 |
4155 3/30/2011 | 11134 Hernandez Bradley 575.00 00 1,500.00 1597 123 E Main Morfalk VA 23510 |
4156 7/22/2011 | 11135 Lewis Shareta 500.00 00 00 1597 Evanston Blvd Toledo OH 43607 |
4157 4/11/2011 | 11137 Willey Lisa 1,000.00 00 00 7896 Anderson Pkwy Southwest Ha... | ME 04679 |
4161 7/22/2011 | 11145 Lasalvia James 500.00 00 3,600.00 123 E Main Morfalk VA 23510 |
4162 7/22/2011 | 11147 Landers Kerr £00.00 00 00 123 E Main Morfolk VA 23510 |
463 7/22/2011 | 11149 Hill Rachel 1,000.00 00 00 123 E Main Morfalk VA 73510 4/18/2011 |
4167 4/22/2011 | 11154 Fucini-Sede... | Bianca 500.00 00| 800000 1902 Greeley STS Apt 4 Stillwater MN 55082 |
4168 5/9/2011 | 11162 Steeves Cheryl Lynn 950.00 00 00 1591 576 Idaho Ave E St Paul MN 55130 |
5/10/2011 | 11164 Handberg Mindy 1,000.00 00 00 12606 123 Washington Ave E St Paul MN 55112 |
5/11/2011 | 7750 Smith Beatrice Anna 750.00 00 00 1666 Coffman St Apt117 | Falcon Heights | MN 55108 |
5/23/2011 | 11106 Hanson Heidi Rae 250.00 00 00 14961 Sumter Ave 5 savage MN 55378 |
| | | 13888831 | 1,125.00 | 1 | 79 | 5 | | | | | |
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The next section will show how to add these columns via formatting, and how to preserve these formats for future use.

#3 — Build Reports (Add Columns) for Memorial/Honorarium Gifts

To add in the information for memorial/honorarium gifts you’ll start by clicking the [Format] button, and select ‘Columns...".
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T3 | File - Edit - I
< Search ¥, Reset | o New ™| EH ¥ & File = Edit - | (0 | Apply to Pledges | Contributions

Q

| Favorites | General | 4 Memory/Honor | Other | Gateway | Contact | SQL |
Q
®

Person:

1

r'd

S8 Edit | FF) Sort |} Format ~|=3 Wrap | %% Export (2 Print | () Pivot |
JAK
|@ Columns... | 4—-F_ e Open Thank Thank
irst . Pledges . You
E, Select saved... Name AT Amount Against [Per Deposited | 40 You
Flednes Date
ke Save Add or remove columns, apply formatting, or specify column attributes. <t S
3625 son | Famela | Whane | 23000 | U | .00 |
Save fs..,
3626 "E dden | Laur Marie 10,000.00 00 .00
3655 | Assign as default.. Elizabeth 100.00 00 00
3905 12/22/2010 | 10974 Adams Leticia 100,00 .00 .00
3907 12/23/2010 | 10976 Lioyd Chelsea 575.00 .00 750,00
3910 12/29/2010 | 10979 Bass Carly 275.00 .00 500.00
3913 1/4/2011 | 11072 Uliman Talia 250.00 00| 3,000.00
1 [ | 2914 172011 | 11078 Cerdic Ay | 276 00 nn 2 000 oo Il =]
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Scroll down the list of columns on the right that are attached to the ‘Contribution’ table, and check the boxes for MemorialPerson and
MemorialTypID.
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9 Column Selection

Columns | Fomat

Table Columns [Contribution]

% MarkethotionExtensionTotal
MarketMotionGty Total

MatchingContributions Expected

MatchingContributionsReceived

Memarial ContactlD

Memarial TypelD

MemoText

ML = MamelnCreditCard

E a @ Contrbution N{:nMnnetarfDescriptiu!'l E|
2 TS T MonMonetaryltemQuantity
= . MonMonetaryRate
@ Address [DefaultDisplay] MonMonetaryRelationld

(5 Address [Home] MonMonetary Typeld

) Address [Mailing] MotifyrCount
OriginalLizbilityDate
PartnerCtrlD

Check the boxes for MemorialPerson and
MemorialTypelD.

[e==n]
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You’ll then need to scroll down the list in the bottom-left under Joined Tables, and select the Memorial Type table.

After the Memorial Type table is highlighted, check the box on the right for Description.
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D ColumnSelection e P e
'l | Columns Fomat

Table Columns [Memarial Type]

i =z %

—
= Include
Memorial TypelD

2

Joined Tabl

e

B Non-Maonetary Type
@l Payment Method
@ Memaorial Tyvpe -‘— 1 E|
B Recumence Type
a4 B Transfer In 7
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This is the column of data that will display and comment/note the donor may have made regarding the memorial/honorarium gift.

Once you're finished selecting the columns you need, click [OK]. You can certainly select more information here if you need to (i.e. phone, email,
etc.) as well as remove columns that aren’t of importance for your report.
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Q- Column Selection

| | Columns | Format

Table Columns [Memarial Typs]

i Rl =
Include ‘il
Memerial TypelD

Joined Tabl

“ e

&) Non-Monetary Type

) Payment Method

@l Memoral Type

@ Recumence Type
4 ) Transfer In
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You'll get a load animation, if it’s a large list of data it could take a few minutes to finish.
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9- Column Selection v .

Columns [Memarial Typs]
= e

=& Include ‘il
Memerial TypelD

Joined Tabl

@l Blection
@ Event

B Non-Maonetary Type

@l Payment Method

@ Memorial Type

@ Recumence Type
4 ) Transfer In
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The new columns will be added to the far-right of the grid. My finished example is below.
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== | L) ¥ @ 19| File - Edit - | ) | Applyto Pledges | Contributions

<3 Search kREset 4 New B
S8 Edit ) Sort ) Format = 53 Wrap @'& Export &Print ) Pivot |

Zip Payment Recurrence .
Code Methad Type Memarial Person Description -

45.00 H[ 9110 Golden Valley Rd Apt10 Golden Valley KN 55427 Credit Card Single [ Steve Jobs2066 Crist Dr.Los... |in memary o

6/22/2016 25,000.00 9110 Golden Valley Rd Apt10 Golden Valley MM 55427 Credit Card Single Prince in memory of
46570 Kristenson oel 6/22/2016 10.00 9110 Golden Valley Rd Apt10 Golden Valley MM 55427 Credit Card single Prince in memory of
46569 Kristenson oel 6/21/2016 6,212,016.00 9110 Golden Valley Rd Apt10 Golden Valley NN 55427 Credit Card Single Prince in memaory of
46492 Zwack James 8/7/2015 45.00 5419 50th Ave N Crystal T 06500 Check Single Bill Moare, in memory of
5597 Kristenson Joel 10/7/2014 1,750.25 9110 Golden Valley Rd Apt10 Golden Valley MM 55427 Credit Card single Test in memory of
5593 Kristenson oel 10/6/2014 12345 9110 Golden Valley Rd Apt10 Golden Valley NN 55427 Credit Card Single Test in memaory of
5589 Eristenson oel 10/6/2014 123.45 9110 Golden Valley Rd Apt10 Golden Valley MM 55427 Credit Card Single Mickey Mouse in memory of
5587 Eristenson oel 10/6/2014 25,000.00 9110 Golden Valley Rd Aptl10 Golden Valley MM 55427 Credit Card single Bob in memory of
5299 Hemshrot Mary 5/3/2012 1,000.00 W5293 Sand Rd Shell Lake WI 54871 Check Single mary's dad Earl in memaory of
3909 Hand Karoline 772272011 20.00 906 3rd 5t S Stillwater MM 55082 Check Single Robert Cleveland in memory of
3827 Todd Candace 12/3/2010 1,250.00 123 E Main MNorfolk VA 23510 Check single in memory of
46554 Aaron Mithran 11/3/2016 5,000.00 595 Vista Ave SE Salem OR 97302 Check Single Steve Jobs in honor of
46502 Eristenson Joel 4/27/2016 2515 9110 Golden Valley Rd Apt 10 Golden Valley MM 55427 Credit Card Single Bobby Joe in honor of
46500 Kristenson oel 4/5/2018 200.00 9110 Golden Valley Rd Apt10 Golden Valley MM 55427 Credit Card Maonthly Steve Jobs in honor of
5600 Kristenson oel 1/29/2015 25,000.00 9110 Golden Valley Rd Apt10 Golden Valley NN 55427 Credit Card Single in honor of
5596 Eristenson oel 10/7/2014 50.00 9110 Golden Valley Rd Apt10 Golden Valley MM 55427 Credit Card Single Test in honor of
10/6/2014 10,000.00 9110 Golden Valley Rd Apt10 Golden Valley MM 55427 Credit Card Single asdf in honor of
5591 Kristenson oel 10/6/2014 1,234.56 9110 Golden Valley Rd Apt10 Golden Valley MM 55427 Credit Card Single A great person in honor of
5590 Eristenson oel 10/6/2014 12345 9110 Golden Valley Rd Apt 10 Golden Valley MM 55427 Credit Card Single Billy Bob in honor of
10/6/2014 25,000.00 9110 Golden Valley Rd Apt10 Golden Valley MM 55427 Credit Card Single Person of Interest in honor of
5585 Kristenson oel 9/29/2014 5,000.00 9110 Golden Valley Rd Apt10 Golden Valley NN 55427 Credit Card Single Billy Bob in honor of
5577 Van Kirk Theodore 7/30/2014 1,945.00 123 Daring Street, Morthumberland PA 12345 Credit Card Single The US Military in honor of
5558 Burton ane B/7/2012 695,00 4567 Oak 5t Fort Atkinson ‘Wil 53538 Check Single Judy in honor of
5292 Phillips Phillies 4/23/2012 100.00 65 trail cir Rochester MM 55901 Check single Tea Time in honor of
5277 Meier David 3/30/2012 350.00 6578 E Hampton Ave 5 Minneapolis MM 55406 Check Single Dave's mom in honor of
5276 Gibson James 3/28/2012 150.00 Check Single Herb Gibson in honor of
5254 Sheehan Ann 2/22/2012 500.00 645 Penn 5t Reading PA 19601 Check Single Ann's Aunt in honor of
5252 Powers ail 216/2012 216.15 1220 Spruce 5t Philadelphia MY 19107 Credit Card Monthly Gail's mom in honor of
5251 Bamford MNancy 2/13/2012 1,000.00 1567 Summit Ave E Renton WA 98059 Credit Card Maonthly nancy's mom in honor of
5241 Jacobowitz Melissa 2/7/2012 1,500.00 1596 Hwy 43 Las Vegas MY 89119 Check Single Melissa’'s Mom in honor of
5237 Hanson Heidi 2/6/2012 700.00 14961 Sumter Ave 5 Savage MM 55378 Check Single Heidi's Mom in honor of
Mercer Cyrstal 2/6/2012 300.00 15987 East Ave Greensboro NC 27406 Check Single Crystals's Mom in honor of
Watts Jennifer 2/2/2012 1,250.00 1687 90th Ave § Eirmingham AL 35216 Check Single Jennifer's friend in honor of
5224 Murphy Jack 1/31/2012 375.00 3697 Main 5t Marrow OH 45152 Check Single Jack's brother in honor of
5204 Donnell Sharonda 1/27/2012 850.00 153 Jefferson Rd Wichita Falls ™ 76301 Check Single Sharonda's Mom in honor of
5206 O'Connor Amy 1/26/2012 900.00 15974 MN Ave Salt Lake City ut 84104 Check single Amy's Sister in honor of

jin} Last Name First Name Date Amount Street ZStreet

City State

6571 Kristenson Joel

5595 Kristenson oel

5588 Kristenson oel

New columns

related to the
memorial/honorarium
person and the

type of gift

(honor of, or

in memory of).

i
ro
(i
&

m
i
L
=

| 6,405,271.46 |||| | | |
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If you want to use this format again the future, click [Format] and select Save As.

<3 Search %, Reset | oF New =l File = Edit = | 0 | Applyto Pledges | Contributions
1
=8 Edit B Sort [EER Format ~ (=3 Wrap Dﬁ Export & Print | B Pivot .
[] (F1LC (MO NS v JAK
@ Columns...
Select zaved... maoun ree I

D Amount Street ;‘t'“t City

[ W | 11/2/2016 45.00 |—” 9110 Golden Valley Rd Apt 10 Golden Valley

Save As... |
,000, olden Valley p olden Valley
4557 b@ | 6/22/2016 25,000.00 9110 Golden Valley Rd Apt 10 Golden Vall
V] | 46570 Aszign as default... L . aoanllloseq Colden Valley Rd Apt 10 Gaolden Vall
VI L [ Save the current format under a specified name Lere e = R
45569 Kristenson Joel Br2LT20T6 B, 2L UTE 0 Golden Valley Rd Apt 10 Golden Valley
Wac ames ! ve rysta

46492 i k J 8/7/2015 45.00 5419 50th Ave N Crystal
5597 Kristenson Joel 10/772014 1,750.25 9110 Golden Valley Rd Apt 10 Golden Valley
5593 Kristenson Joel 10/6/2014 12345 9110 Golden Valley Rd Apt 10 Golden Valley
5589 Kristenson Joel 10/6/2014 123,45 | ||| 9110 Golden Valley Rd Apt 10 Golden Valley
5587 Kristenson Joel 10/6/2014 25,000.00 9110 Golden Valley Rd Apt 10 Golden Valley
5299 Hemshrot kary 5/3/2012 1,000.00 Wa293 S5and Rd Shell Lake
3909 Hand Karaling 72272011 20.00 906 3rd 5t S Stillwater
2627 Todd Candace 12/3/2010 1,250.00 123 E Main MNorfolk

Provide a descriptive name and click [Save]. Formats will *only* be saved in the list where they were created, in this case, the Contributions list.
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1. Create a descriptive name.

e Save Format .

EName: Memorial/Honorary Repurtl

) Events Report
R JAK

EEF Name Morth Year
@ Meeds a Thank-You Letter
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You can reload the format in the future by clicking [Format] > Select Save:
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B) Settings Help

Application Menu s Search %, Reset | 4k New M CF B File » Edit + | () | Applyto Pledges | Contributions
Bl=® Q

Tasks Favortes | General| & Memory/Honor | ther | Gateway | Contact | saL |

»» [[E Dashboard

- g Organization ED = '

i § Calendar/Tasks Memory/Honor Memary,Honor

[ % Canvassing 75

4 % Contact @ \ E _ k. X EE =
[BE Contacts Type:
@ Addresses ~ -

Person:

@ Households
IEH Contact Relationships
4 @ Contributions/Pledges
@y Contributions
@y Contribution Allocations
¥ Contribution Matches
@ Contribution Motifications

Fledges /
Pledges, Detail

[=] Thank You Letter - Contributi ‘
;- [ Reports 8 Edit &) Sort & Format ~ =3 Wrap mﬁ Export & Print | Pivot
i /% Product Sales :
[ 'f} Logs
I+ % Communications
[ a Financial
i % System Manager

Contributions [ 94 r JAK

“nlmns Open

] Applied
First . Pledges
| Mame MI Amount Against [Per

Pledges

<]

Select saved... Deposited

Contact]

a
Save
[ Select a previou sly saved format to apply to this display grid pLllds 00 00 I_

Save Ao
Anders 45.00
Anders 25,000.00

]

—
(=]
1B

Assign as default.., son

—
=]
[}

6/22/2016 | 12796 Kristensan
6/21/2016 | 12796 Kristensan
4/27/2016 | 12796 Kristenson

4/5/2016 Kristenson

Anders 10.00

—
=]
=

Anders 6,212,016.00
Anders 2515
Anders 200,00

—
(=]
LR

—
=]
LR

EHEHENENEE =

&
[}
| O|OOOa|@
| OOO0EEEE
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You can also assign it as ‘your default’ or the ‘global default’ by click [Format] > Assign as default...
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<3 Search %, Reset | 4k New o= b ¥ @ File ~ Edit - | ) | Applyto Pledges | Contributions
QD
| Favorites | General | /* Memory/Honer | Other | Gateway | Contact | SQL |

==

MemaryHonar | Mmﬂ-jm|
Q% D0 U % X|HIFIE @ sa

* Type: [in honor of v]

Person:

~

SE Edit | Sort [ Format »|S3 Wrap | 8% Export 2% Print | () Pivot |
JAK
B Columns.. _ applied Open Thank —
First . Pledges . You
E, Select saved.., Name M1 Amount Against [Per Deposited | . You
Pledges Contact] sent Date
ki Save
F F
Save Az,
P on Joel Anders 45.00 .00 .00
B Assign as default... on loel Anders 25,000.00 .00 .00
4557;] ————r——— Joel Anders 10.00 .00 .00
46569 6/21/2016 | 12796 ﬂ-[ Assign a default format to be used when displaying informaticn in this grid l 00
45502 472772016 | 12796 Kristenson lael Anders 2515 A0 4]
1 46500 4/5/2016 | 12796 Kristenson Joel Anders 200.00 00 00
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The related resources below link to a variety of videos and articles related to this topic.

999

Trail Blazer

- YouTube Channel
- Knowledge Base Articles
- 3rd Party Resources
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Related Resources

Article: Save and Load a Search Query as a (Dynamic) Search Favorite
Article: SQL Wildcards
Article: Inserting Contribution Transactions In Donor Merge Letter

Article: How to Delete or Rename a Saved Search Favorite (Query)

Article: Tax Deductible Contributions

Article: Recording Non-Monetary (In-Kind) Contributions and Creating New Non-Monetary Types

Article: Matching Contributions

Article: Contributions Year-End Report

Article: Enter Contributions

Video: Getting Started 102 Beginning Queries - Nonprofit

Video: Reporting 102 — Quick Reports and Export

Video: Getting Started 107 — Writing Contribution Thank You Letters
Video: Write Letter — Edit Letter after Mail Merge

Video: Reporting 104 — Joined Tables

Video: Reporting 105 — Pivots — summary reporting

Video: Getting Started 104 Queries with wildcards

Video: Favorite — Update and Delete Favorite

Video: Getting Started 106a — Entering Contributions (NON PROFIT ONLY)
Video: Reporting 103 — Format with various contribution columns
Video: Getting Started 107 — Writing Contribution Thank You Letters
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Trail Blazer Live Support

© Phone: 1-866-909-8700
® Email: support@trailblz.com

E? Facebook: https://www.facebook.com/pages/Trail-Blazer-Software/64872951180
B Twitter: https://twitter.com/trailblazersoft

* As a policy we require that you have taken our intro training class before calling or emailing our live support team.
Click here to view our calendar for upcoming classes and events. Feel free to sign up other members on your team for the same training.

* After registering you’ll receive a confirmation email with the instructions for how to log into the GoToMeeting session where we host our live
interactive trainings.

* This service is included in your contract.

KNOWLEDGE BASE www.trailblz.com/kb 39



http://www.trailblz.com/kb
mailto:support@trailblz.com
https://www.facebook.com/pages/Trail-Blazer-Software/64872951180
https://twitter.com/trailblazersoft
http://trailblz.com/Support/Learning/Events.aspx
http://www.joingotomeeting.com/
http://www.google.com/url?sa=i&rct=j&q=&esrc=s&frm=1&source=images&cd=&cad=rja&docid=OWWX4dkzm0Ht9M&tbnid=fvnmGEIR8WcqlM:&ved=0CAUQjRw&url=http://sisyphus-js.herokuapp.com/&ei=8c93UqrcFYj_qgHr4oGADw&psig=AFQjCNEn8KDSLHIodKJmcApCrvnIZvl23g&ust=1383670048026187

